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Chapter 1
Introduction

This document provides information on the Passport 4400, Release 4.0 product 
available for general customer release. This document includes information about 
the Passport 4400 unit, the system software, Command Line Interface (CLI), 
Passport 4400 Configurator, and Install Tool. You will find information on the 
software files, the documentation, and the new features. Additionally, there is a 
section on current known issues with the software and a section for manual 
updates.

Occasionally, throughout this document, you will find at the end of a sentence or 
paragraph an 8-digit number in parenthesis (for example, 60058007 or 10265987). 
This number is an internal Service Request (SR) number used to track problems 
and fixes to the product software or its documentation.

Documentation

 The documentation consists of the following:

• Passport 4400 Hardware Installation Manual, 800-1951-40 (provided in hard 
copy with your Passport unit)

• Using Passport 4400 Install Tool Version 4.0, 800-1983-40 (provided in hard 
copy in the Passport software kit)

Note: Release Notes are updated on an as needed basis. Please check the 
Web Page (http://support.baynetworks.com/library/tpubs) to find out if 
there is a more current revision.
Passport 4400 Release Notes for R4.0
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8 Chapter 1 Introduction
• Passport 4400 Release 4 Configuration and Operation Document (provided 
on CD-ROM, this is software documentation for the system and all module 
options - except LDM - describing configuration/provisioning using the 
Passport 4400 Configurator and CLI)

• Release Notes, 800-1953-40 (this document)

• Legacy Data Services Manual, 800-1961-20, Rev B (describes the LDM 
software)

• Passport 6400, 4400 Interworking Guide, 241-6401-115

• Passport 4400 and 6400 Quick Start Guide, 241-6401-280

These documents are directly accessible from Web Page URL:
http://support.baynetworks.com/library/tpubs. Select Passport 4400, then Release 
4.0. The documents are accessed from the links shown. We recommend that you 
save the document locally and then open it. These documents are also available on 
the software/documentation CD-ROM. These documents may be undated, so to 
ensure the most recent version, refer to the web page.

Online Documentation

Passport 4400 Configurator Documentation URL Update

When you have installed the online documentation, you must set the 
documentation URL for the Passport 4400 Configurator in order to be able to 
access the online documentation (Passport 4400 Release 4 Configuration and 
Operation Document) from within the Passport 4400 Configurator.

This URL can only be changed through the Passport 4400 Configurator web 
pages.

1 Click on Administration.
Part No. 800-1953-40, Rev. C
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2 Click on Document URL. The Documentation URL window opens:

The URL in the window is where the online documentation is located, at the 
Nortel Internet site, on your PC, workstation, server, or on the CD at your PC.

3 If you have downloaded the documentation elsewhere, enter the URL in the 
Documentation Server URL field, and click Save. A “Command Successful” 
appears.

Accessing the Online Documentation

• Directly access the documentation:

• From the Internet, you can access the documentation from this URL:

http://support.baynetworks.com/library/tpubs/passport/v40/index.html

• From the Passport 4400 Software/Documentation Distribution CD ROM, 
you can access the documentation using a PC from this path:

D:\docs\Config_Ops_Doc\index.html

(where D: is the drive letter of your PC's CD ROM)

• Open the documentation:

Note: Documentation is sometimes updated and posted on the web 
page, http://support.baynetworks.com/library/tpubs/passport/v40/
index.html. Check that location to ensure that you have the latest version.

Note: Some browsers require special setup. See the Browser 
Information section, which follows.
Passport 4400 Release Notes for R4.0
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10 Chapter 1 Introduction
• If you are using the Passport 4400 Configurator, click on the 
Documentation link in the navigation menu. The online documentation 
will display in a new browser window.

• If you have installed the online documentation onto your PC's hard drive, 
you can access the documentation by opening the file named index.html, 
located in the directory where you installed the documentation.

• If you have installed the online documentation on a Web server, the URL 
you must use depends on where the documentation is installed on the 
server and how the Web site is configured and managed by the server's 
administrator or WebMaster. An example URL could be the following:

http://yugi/

(This URL assumes that the server's name is yugi, the documentation is in 
the root directory of the Web site established on the server, and that 
index.html is the default file that is served when the Web site is accessed.)

The server name “yugi” can be resolved by DNS; otherwise, use your 
server’s IP address. An example could be the following:

http://192.168.1.1

Browser Information

The Passport 4400 Release 4 Configuration and Operation Documentation 
(hereafter referred to as The Online Documentation) has been tested with the 
following browsers:

• Microsoft Internet Explorer 3, 4, and 5

• Netscape Communicator 4.5, 4.6, and 4.7

• Netscape Navigator 3 and 4

• Opera 3.60

• Mosaic 3

The Online Documentation has been tested with the following operating systems:

• Microsoft Windows 95

• Microsoft Windows NT 4, Workstation and Server

The best results are obtained when using the following combination:
Part No. 800-1953-40, Rev. C
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Microsoft Internet Explorer 4 and 5 on a Pentium PC running Microsoft 
Windows 95 or NT, having a display of 800 by 600 minimum resolution and 
capable of displaying 32,000 colors or more.

Use the following table to get the optimum results from the browser you are using.

Browser How to Get Optimum Results

Microsoft Internet Explorer 4 or 5 Normal browser setup will provide optimum results.

Microsoft Internet Explorer 3 For best results, you should set the browser to 
disable using style sheets:
1. Select View -> Options and select the Advanced 

tab. 
2. Uncheck the box next to Use style sheets. 
3. Click on the Apply button. 

Also, you should choose the No Frames option from 
the online documentation startup page. The frameset 
for the online documentation may not be stable in 
Microsoft Internet Explorer 3. You may encounter 
pages displayed outside of the frameset.

Netscape Communicator 4.5,

 4.6, 4.7

As a minimum, you should make sure the browser 
window size is at least 800 by 600 pixels. If you must 
run the browser in a smaller window size or you 
encounter display problems, you should set the 
browser to Disable using styles sheets:
1. Select Edit -> Preferences and select Advanced. 
2. Uncheck the box next to Enable style sheets.
3. Click on the OK button. 

Netscape Navigator 4.08 As a minimum, you should make sure the browser 
window size is at least 800 by 600 pixels. If you must 
run the browser in a smaller window size or you 
encounter display problems, you should set the 
browser to Disable using styles sheets:
1. Select Edit -> Preferences and select Advanced. 
2. Uncheck the box next to Enable style sheets.
3. Click on the OK button. 

Netscape Navigator 3 Normal browser setup will provide optimum results. 
However, Navigator 3 does not support cascading 
style sheets, so the browser's default fonts are used. 
Navigator 3 uses serif fonts, black on a white 
background, as the default display.
Passport 4400 Release Notes for R4.0
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Navigating the Passport 4400 Release 4 Configuration and 
Operation Documentation (Online Documentation)

The next and previous buttons in the document pages navigate you through the 
pages sequentially. If, for example, you have jumped (hyperlinked) to a new page 
and wish to return to your previous location, use the back button in the browser.

Opera 3.60 Normal browser setup will provide optimum results.

Mosaic 3 Normal browser setup will provide optimum results. 
However, Mosaic 3 does not support frames or 
cascading style sheets. The browser's default font 
set is used. Also, when you access the Passport 
4400 Configuration and Operation Documentation 
with Mosaic 3, you will see a message that the 
browser does not support frames. Just click on the 
link provided to use the documentation without the 
frameset.

Browser How to Get Optimum Results

PREV. This takes you to the 
previous page in the document 
regardless of how you got to 
this page. Do not confuse this 
PREV with BACK.

NEXT. This takes you to the 
next page in the document 
regardless of how you got to 
this page.

BACK. Returns you to the previous 
display. This is good for jumping 
between procedures or returning 
to the previous screen after a 
hyperlink jump.
Part No. 800-1953-40, Rev. C
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There are four navigation tools to help you locate the information you require:

• the navigation tree in the left window.

• the table of contents accessible from the TOC button on each page.

• the index accessible from the index button on each page.

• the site map in the right window (accessed from the navigation tree). This 
is shown on next page.

Site Map: see 
illustration 
which follows

Navigation Tree: 
Click on a major 
topic and sub 
topic will display.

TOC: Table of Contents. This will 
take you to a comprehensive 
Table of Contents (many pages). 
It is not the preferred method. 
Note that the Table of Contents 
does not match either the 
Navigation Tree or the Site Map. 
It is merely a different method of 
navigation.

Index: This will 
take you to the 
Index.
Passport 4400 Release Notes for R4.0
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Site Map

The site map is an expanded version of the Navigation Tree. It permits you to 
browse through the documents to select the items you wish to view.

From any place in the 
documentation, select Site Map 
from the Navigation Tree to 
display the Site Map.
Part No. 800-1953-40, Rev. C
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Within the documentation, there are two additional aids to help you: the end of 
topic sign and the end of procedure. When you see these aids, you have reached 
the end of the logical discussion. By pressing next you will be moved to new topic 
which may be completely unrelated.

Printing Online Documentation

In some cases, the HTML pages will not print properly. For print purposes, a copy 
of the documentation in PDF form is provided (config_ops_doc.pdf). Use the PDF 
file for printing requirements. It is recommended that you use a PostScript printer 
driver. (60101046, 60106502)

This is the end of this topic. By pressing the 
next button, you may or may not be at the 
next logical topic.

This lets you know that this 
procedure is now complete.
Passport 4400 Release Notes for R4.0
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Passport 4400 Hardware Requirements

• Make sure that you have the 16 MB Flash SIMM installed.

• Ethernet Base Module: NTAU01BA or later.

• Model BA is required to support the hardware compression SIMM.

• If you do not require hardware compression, you can use an NTAU01AA, 
Rev .08 or later and upgrade it to 16MB Flash.

• NTAU01CA Rev .05 or later is required to support the new ISDN module 
NTAU76CA, Rev .03 or later. If you are installing the new ISDN-BRI 
Module NTAU76CA, and you are unsure of the base module, contact 
your Certified Distributor and request that they contact Nortel Networks 
(refer to ECO E400399).

• In a Passport 4450, if the ISDN Module is in the top slot, you must use 
Rev .03 or later.

• HDM 8-port Module: Your HDM must be Rev .06, but it is recommended you 
use Rev .08 or later. There is a known problem with Rev .05 and earlier that 
requires a factory upgrade. For additional information, contact your Certified 
Distributor.

Checking Your Ethernet Base Module Part Number

The face plate on the Ethernet Base Module contains a tag with your part number.

Note: All Ethernet Base Modules shipped after January 2000 will be 
NTAU01CA, Rev .05 or later.
Part No. 800-1953-40, Rev. C
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Software and Documentation CD-ROM

Copy the appropriate files from the CD-ROM to your TFTP server. The CD-ROM 
contains files for the following items:

• Software

— Install Tool

— Passport 4430/50

— Passport 4455

— Legacy Data Module

• All Product Documentation

Software

Install Tool

• it400104.exe

Passport 4430/50

• bt4002418.bld (Passport 4430/50 boot code)

• bt4002418.bin (Passport 4430/50 boot code binary image)

• pr4002418.bld (Passport 4430/50 application code)

• pr4002418.tar (Passport 4430/50 MIB files in tar format)

• pr4002418.zip (Passport 4430/50 MIB files in zip format)

• rs4002418.pdf (These Release Notes in PDF format)

• rs4002418.ps (These Release Notes in PostScript format)

Passport 4455

• thb4002418.bld (Passport 4455 boot code)

• thb4002418.bin (Passport 4455 boot code binary image)

• th4002418.bld (Passport 4455 application code)

Boot Code: Passport_4430/50_Boot_Rel_4.0.0_Rev 2.41.8 05/17/00 08:08:39

Application Code: Passport_4430/50_Appl_Rel_4.0.0_Rev 2.41.8 05/17/00 08:09:04
Passport 4400 Release Notes for R4.0



18 Chapter 1 Introduction
• th4002418.tar (Passport 4455 MIB files in tar format)

• h4002418.zip (Passport 4455 MIB files in zip format)

• rs4002418.pdf (These Release Notes in PDF format)

• rs4002418.ps (These Release Notes in PostScript format)

LDM

• ACCGFELX.FIM0200 (LDM code 2.0 for Passport 4400)

• r020.pdf (Release Notes for LDM code 2.0 in PDF format)

• r020.ps (Release Notes for LDM code 2.0 in PostScript format)

All Product Documentation

• m195140a.pdf (Hardware Installation Manual)

• m198340a.pdf (Using Install Tool v4.0)

• 64n115.pdf (Passport 6400, 4400 Interworking Guide)

• 64n280.pdf (Passport 4400 and 6400 Quick Start Guide)

• m196120B.pdf (Low-Speed Data Services Manual) (LDM)

• config_ops_doc.pdf (Configuring and Operating Passport 4400 Software in 
pdf format-delivered for printing requirements)

• config_ops_doc.exe (Configuring and Operating Passport 4400 Software in 
self-extracting executable archive format)

• config_ops_doc.tar (Configuring and Operating Passport 4400 Software in 
Unix format)

• ConfigOpsDoc (Configuring and Operating Passport 4400 Software files 
uncompressed, accessible from the CD-ROM)

• rs4002418.pdf (These Release Notes, 800-1953-40, Rev B in Adobe Acrobat)

• rs4002418.ps (These Release Notes, 800-1953-40, Rev B in PostScript)

Boot Code: Passport_4455_Boot_Rel_4.0.0_Rev 2.41.8 05/17/00 08:48:49

Application Code: Passport_4455_Appl_Rel_4.0.0_Rev 2.41.8 05/17/00 08:49:08
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Application Code

The Passport 4400 application software is a single file (either thxxxxx.bld or 
prxxxxx.bld) supplied in a “bld” format consisting of the following six executable 
images:

• Ethernet Base Module code (Version Passport 4430/50. Appl. Rel. 4.0 Rev or 
Passport 4455/50. Appl. Rel. 4.0 Rev)

• DSP code for AVM (Version 2261 XAP)

• DSP code for UAVM (Version 2263 XAP)

• DSP code for the DVMs installed on the TVM, EVM, and DVEM (Version 
2262 XAP)

• Code for the TVM (Version 909-2291 AX5)

• Code for the EVM (Version 909-2292 0A)

Note: You can show these versions by issuing the following CLI 
command show system image.
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Upgrading from Previous Releases

• The 16 MB Flash must be installed before upgrading. If it is not and you 
attempt to upgrade, an error message similar to the example will display:

Important! Always extract the latest MIBs from the software bundles and 
replace your old MIBs with the most current version. If there are several software 
versions, use the most current version of the MIBs.

Upgrading from Release 2.0

Note: Be sure to upgrade your base unit and all your voice modules. 
This ensures that the unit will support all Release 4.0 functionality.

Note: You can only upgrade from 2.0, if your hardware supports the 
upgrade. See the Hardware Requirements.

CLI>
Bus Error
Program Counter: 0x11008b36
Status Register: 0x3004
Access Address : 0xffffffff
Special Status : 0x0085
Task: 0x11c381dc "TftpHndlr"
WachDogTask: TftpHndlr task is suspended with taskStack info:
11266650              : 11140ade (0, 0, 0, 0, 0, 0, 0, 0, 0, 0)
11140bc6              : 11141148 ([0, 0, 0, 11266652, 0])
11141218              : 11141598 ([0, 0, 0, 114a9874, 0])
1114168e              : 111418dc ([11c38126, 1, 1, 114a9874, 11c30001)
11141916              : 111430ee (11c10ae8, 200)
111433aa              : 111439a0 (2)
11143a7e              : 11143afa (11c13f28, 2, 7)
11143b8e              : 11008a8e (d5, 0)

RESETTING the system in 5 sec ...
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If you are upgrading from Release 2.0.3 through 2.0.7 to Release 4.0, you must 
first upgrade to Release 2.0.8 or later before upgrading to Release 4.0. This 
phased approach will preserve your custom configuration. Refer to the Procedure 
for Downloading Application Software; for this upgrade, you must use the CLI 
procedure.

Additional Considerations:

• When upgrading from Release 2.0.9.0.1. and earlier to Release 2.0.10 and 
later, your must first set fax rate parameters to 7200b/s. Once the upgrade is 
complete, you can set the fax rate as required. Refer to page 41, General 
Operational Notes (fax rate), for additional information. (10309543)

• When upgrading from Release 2.0.x to 4.0, any IP routing RIP compatibility 
parameters that were configured as RIP1 will be converted automatically to 
RIP1Compatible. If RIP1Compatible is not the desired RIP setting, you will 
need to change this parameter back to RIP1.

Upgrading from Release 3.1

Refer to the Procedure for Upgrading Application Software which follows. For 
this upgrade, you must use the CLI procedure.

• IP Prioritization compatibility between Release 3.1 and Release 4.0: Do not 
enable IP Prioritization until all units in the network have been upgraded to 
Release 4.0. Release 3.1.x units do not recognize or support IP Prioritization.

• Hoot N Holler compatibility between Release 3.1 and Release 4.0: In mixed 
networks, the Release 4.0 units should be set to Master, not Slave.

• Idle Char parameter: In Release 3.1.3 and earlier, the default of 255 invoked 
the 7E idle character. In Release 3.1.4 and later, 255 sets the character to mark 
fill (FF). In Release 3.1.6 the default will be changed to 126 (7E), so if you 
factory default the unit, the idle fill character will be 7E (126). If you are 
upgrading from 3.1.5 or below and do not factory default the unit, you must 
manually change the parameter to 126 (7E). (60319119)

Note: You can only upgrade from 3.1, if your hardware supports the 
upgrade. See the Hardware Requirements.
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Upgrading from Release 4.0 (Controlled Releases)

Refer to the Procedure for Upgrading Applications Software which follows. For 
this upgrade, you can use either the Passport 4400 Configurator or CLI.

Downloading Software Using CLI

Procedure for Downloading Boot and Application Software 
Using the CLI

1 Load the Passport 4400 Release 4.0 software onto your TFTP server (boot and 
application code as required).

2 If necessary, start a Telnet session with the Passport 4400 and access the CLI.

3 If necessary, disable weighted round robin traffic management: 

define tm weightedRoundRobin disabled

4 Download the boot code.

Example:

download base image specific 192.168.15.30 “bt4xxxxx.bld”

This will download the file bt4xxxxx.bld from the TFTP host with the IP 
address 192.168.15.30 (where x’s represent the current version/filename).

5 Download the Release 4.0 application code onto the Passport 4400 using 
TFTP.

a Commit the application code bank that will be write-protected during the 
download. 

Note: You can use this procedure for upgrading software for all releases 
(including 2.0 and 3.x.x).
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Example:

set system firmware commitcodebank bank1

This will write-protect application code bank 1. The application code will 
be downloaded into bank 2.

b Download the application code. 

Example: 

download base image specific 192.168.15.30 
"pr4xxxxx.bld"

This will download the file pr4xxxxx.bld from the TFTP host with IP 
address 192.168.15.30. (Where x’s represent the current version/
filename)

6 Commit the new application software to the write-protected bank.

Example:

set system firmware commitcodebank bank2

7 Restart the Passport 4400 unit: 

reset system current reset

8 Reconnect to the CLI. If necessary, establish another Telnet session with the 
Passport 4400 unit.

9 Re-enable weighted round robin traffic management, if it was disabled 
previously:

define tm weightedRoundRobin enabled

10 If you used RIP1 operation, the upgrade will change the operation to 
RIP1compatible. To return to RIP1 operation, enter the following:

define ip base ripCompatibility rip1

11 The last step is to extract the latest MIBs from the software bundle and 
replace your old MIBs with the new ones. If there are several software 
versions, use the most current version of the MIBs.
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Procedure for Downloading DSP and T1/E1 Module Software Using 
the CLI

When the Passport 4400 unit initializes for the first time using the 4.0 software, 
one or both of the following messages may be displayed on the CLI (60105233, 
60105242):

• DSP software version on the voice module (version number) does not match 
the one in image bundle (version number). Downloading the new voice 
software is mandatory.

• E1/T1 software version on the E1/T1 module (version number) does not 
match the one in image bundle (version number). Downloading the new E1/
T1 software is mandatory.

The following procedures should then be performed (as required):

• Downloading Voice Software

• Downloading T1/E1 Software

Procedure for Local Download of Voice Software Using CLI

1 Enter the following command to download 4.0 voice software to a specific 
voice channel on your Passport 4400 unit:

CLI> download voice channel (card number) (channel 
number) download

2 Enter the following command to download 4.0 voice software to all voice 
channels on your Passport 4400 unit:

CLI> download voice allChannels download

Note: You cannot use the Passport 4400 Configurator to perform the 
procedures described in this section.

Logical Location 
number:

LimB | LimC | LimD | LimE The location of the voice module 
within the Passport 4400 unit.

Channel number: INTEGER (1..12) The voice channel number.
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Procedure for Local Download of T1/E1 Software Using CLI

Enter the following command to download Release 4.0 T1/E1 software to the T1/
E1 module on your Passport 4400 unit:

CLI> download t1e1 download

Downloading Software Using the Passport 4400 
Configurator

Procedure for Downloading Application Software Using the 
Passport 4400 Configurator

Use the procedure below to download application code. The following steps must 
be performed:

• Commit the application code bank.

• Enter the IP Address of the TFTP host workstation that contains the download 
code files.

• Save the Current Configuration and Reset the Unit.

Commit the Application Code Bank

1 Click on Administration.

Note: This procedure works for downloading software at Release 4.0 
and later. You cannot use the Passport 4400 Configurator for upgrading 
from Release 3.1.x and earlier.
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2 Click on Code Bank. The Code Bank window opens:

3 Next to Commit Bank, use the pull down menu to select 1.

Bank 2 is now uncommitted, and a subsequent application code download 
will write to Bank 2.

4 Click Save. A “Command Successful” appears.

Enter the IP Address of the TFTP Host Workstation that Contains 
the Download Code Files

1 Under Administration, click on TFTP Operation. The TFTP Operation 
window opens:
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2 In the Server IP field, enter the IP address of the TFTP host workstation where 
the download code files reside.

3 Click Save. A “Command Successful” appears.

4 At the top of the window, click on Code Download. The TFTP Code 
Download window opens:

5 In the Filename field, enter the filename and path (if applicable).

6 Click Download (from Server). The TFTP Status window opens:

This window displays the progress of the download process.

7 You must reset the unit and save the configuration. Refer to Save the Current 
Configuration and Reset the Unit.
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Save the Current Configuration and Reset the Unit

1 Click on Administration.

2 Click on System Reset. The System Reset window opens.

3 In the Reset Type field, use the pull down menu to select Configuration. Click 
Reset. A unit reset confirmation message is displayed.

4 Click OK. A display will show you the reset progress.

When the autoboot sequence begins, the newly-saved configuration in bank 4 will 
be read and loaded into DRAM, and the rollback timer will start.

Upgrading DSP Code and T1/E1 Module Software Using 
Passport 4400 Configurator

Configurator Procedure for Downloading the Local T1/E1 
Software

Note: This procedure works only for downloading Release 4.0 and later 
software. You cannot use the Passport 4400 Configurator web pages for 
upgrading from Release 3.1.x and earlier.
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1 To begin downloading local T1/E1 software, select Configure, Voice, and 
System Action.

You will see the Voice System Action window:

2 At the top of the window, select the T1E1 System Action link. You will see the 
T1E1 System Action window:

3 Use the pull down menu to select download. 

4 Click Save. A “Command Successful” appears. The download is now being 
performed. 
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Configurator Procedure for Downloading the Local Voice 
Software

The following procedure executes a voice download for all voice channels. The 
Configurator does not perform specific voice channel downloads.

1 To begin downloading local voice software, select Configure, Voice, and 
System Action.

You will see the Voice System Action window:

2 Use the pull down menu to Download.

3 Click on Save. A Command Successful appears. The download is now being 
performed.

Note: This procedure works only for downloading Release 4.0 software 
and later. You cannot use the Passport 4400 Configurator web pages for 
upgrading from Release 3.1.x and earlier.
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Returning to Release 3.1.x

Returning to an earlier release is a difficult process, which should only be 
attempted by your Certified Distributor. All application files and configuration 
must first be removed using the bootup menu. Bootcode and image must then be 
downloaded to the unit. (50125969)

Upgrading Install Tool from Previous Releases

Install Tool is the recommended tool for initially configuring the basic services of 
your Passport 4400. It is sufficient to make the unit accessible within a Passport 
network. Install Tool Version 4.0 supports Release 4.0 and Release 3.1 of the 
Passport 4400 software. To install Install Tool, you must first remove the previous 
version of the software. Since configuration parameters are not stored in the 
software, you will not lose any previous configuration. Refer to Using Passport 
4400 Install Tool v4.0 for instructions in installing and initializing the software.

Passport 4400 and 6400 Interworking

For proper interworking between the Passport 4400, Release 4.0 and the Passport 
6400, the following 6400 release levels are required:

• Release 5.1

• Release 5.0

• Release 4.2

Note: Support for Passport 6400 Release 4.2 and 5.0 is not available 
after June 30, 2000. For more information, contact your Certified 
Distributor or Account Manager.

Note: Not all Passport 4400 features are supported on all releases of 
Passport 6400. Check with your Certified Distributor or Account 
Manager to understand the feature set compatibility.
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Network Management

• OMS Release 4.0.1.

• NMS Release:

• 11.3 C (You will need the 11.3 CD plus the 11.3C CD for 4400 
management). This one is recommended for Release 4.0.

• 11.2 (plus the NMS 11.2C companion CD).

Note: When configuring FRDCE service with frame relay SVCs 
between a Passport 4400 and the Passport 6400, the Passport 4400 must 
be set to Master, and the Passport 6400 to Slave. Traffic Management 
with rate enforcement “enabled” allows for correct operation of the 
configured CIR bandwidth. (60107059)

Note: If you are using the SNMP Integrator for Passport 4400 
Management in NMS 10.9, upgrading involves an HP OpenView-based 
solution. You will need HPOV 5.01 or 6.01 as part of the Passport 4400 
data collection to feed into NMS.
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Chapter 2
New Features and Software Enhancements

New Hardware Features for Release 4.0

Voice/Fax Switching Interface Module

Introduced in this release, this module combines an FXS interface with a 
line-sharing/fax-sharing unit, which permits a fax machine to receive a call from 
either a voice/fax channel in the Passport 4400 network or from the PSTN.

Hardware Data Compression

• SIMM that plugs into base module.

• Hi-fn (STAC) chip, providing a 2:1 compression ratio.

• Conforms to FRF.9.

• Additional compression achieved through idle flag suppression.

• Compression configurable for all RFC 1490 data streams such as SNA traffic, 
IP/IPX LAN traffic, and X.25 traffic.

• Modes 0, 1, and 2.

ISDN Module Update/Upgrade (NTAU76CA)

• External synchronization is now provided via a clock sync module 
(daughterboard) installed on the BRI module.

• No configuration required to operate this feature. The module will always 
look for its clock source from WAN 2 port when configured as NT.
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• Requires Ethernet Base Module NTAU01CA Rev. 05 or later.

Note: The connections will depend on the specific site requirements. If 
you are not sure of the connections required for the Passport 4400 unit, 
consult your system administrator or Certified Distributor.

Note: Refer to the Manual Update section of these notes for additional 
information on this module.

Passport 4400 Passport 4400

Master 
Clock Source

2-4 ISDN
BRI Lines

Synchronized to 
PSTN VIA 4400

2-4 ISDN
BRI Lines

Synchronized to 
PSTN VIA 4400

WAN Port 2WAN Port 2

Passport 4400 Passport 4400

Passport
PBX

PBX

ISDN PRI
(VIA MVP)

Siemens
Hicom 118

PBX

Siemens
Hicom 118

PBX

Local Bank Branch Local Bank Branch

Central Call Center

ISDN
PSTN

NT NT
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New Software Features for Release 4.0

LEAPS (Legacy Access Protocol Services)

• New legacy services that connect directly to the base and HDM serial ports.

SNA Services

• SNA Services provide the Passport 4400 unit the ability to switch and 
transport SNA over SDLC and SNA over LLC2 (Ethernet). SNA data can be 
switched between local ports on the unit, or, data can be carried across the 
WAN over a PANL link or over a frame relay network. SNA SDLC supports 
the following:

• multi-drop

• local spoofing

• When sending SNA services over the WAN, either SDLC or LLC2, all 
packets are encapsulated in Boundary Access Node (BAN). BAN 
encapsulation allows connectivity to the following:

• Passport 6400,

• Bay router products, and

• 3rd party FRADs.

X.25 Services

The X.25 services provide connectivity between X.25 data terminal equipment 
(DTE) over a Passport WAN (PANL). The X.25 services also support X.25 calls 
between a DTE connected to a Passport 4400 unit and a DTE connected to a 
FRAD over a frame relay network using RFC 1490 PVC conforming to ANSI 
T1.617a 1994 Annex G. The X.25 services include the following:

• local flow control

• local termination and spoofing

• switching to multiple destinations

• X.25 PVCs and SVCs
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Async over TCP/IP (AOT)

• A wide area network protocol that enables transport of asynchronous data 
packets over a transmission control protocol/internet protocol (TCP/IP) 
network. TCP/IP transport provides built-in error correction.

• Can either be a point-to-point or multi-point interface.

• X-on/X-off software controls/prevents data loss.

OSPF (Open Shortest Path First)

OSPF minimizes network convergence times within IP networks. OSPF is an IP 
routing protocol, classified as an Interior Gateway Protocol (IGP). This means 
that it distributes routing information between routers belonging to a single 
Autonomous System (AS). The OSPF protocol is based on link-state or Shortest 
Path First (SPF) technology. OSPF allows interworking with Passport 6400, Bay 
Routers, and third part FRADs/Routers.

IP Filtering and Prioritization

IP Prioritization is used in the Passport 4400 network to enhance the performance 
of various application packets. Application packets are often transferred with 
regular traffic. If priority control has not been configured, smaller packets are 
blocked by larger ones, which can cause long delays and packet loss.

IP Prioritization enables three SVCs utilizing high, medium, and low traffic 
management.

Note: If a multi-point network is required, an AN/ARN router 
must be used as the multi-point node.
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The IP traffic filtering and prioritization feature allows you to configure the 
prioritization of an IP packet based on the layer protocol type, source address, 
destination address, and port number.

Support for Dual DHCP Servers

This feature offers redundancy if the primary DHCP server is unreachable.

Auto Ring Down (ARD)

• When the telephone goes off-hook, the remote side rings with NO set up 
delay. This is used with Hoot N Holler for “nailed up” applications.

• Enables voice mail applications by passing the call through to the remote end 
causing the remote phone to ring. If there is no answer, the call will go to 
voice mail.

Premium Voice (Tandem Voice Passthrough)

• Compressed voice is now passed through a tandem PBX without 
decompression.

• PBX provides CCS switching without additional voice delay.

Voice over IP (VoIP)

• Voice over IP over Ethernet and frame relay. 

• Voice over IP is a new service that allows voice calls to be transported within 
Ethernet LANs, the Internet, and corporate TCP/IP networks. This new 
service uses:

• NAS/NAC (Directory Server) for automated look up and routing of calls,

Note: IP Prioritization is a PANL feature only.

Note: This feature only works with another Passport 4400 with Release 
4.0.
Passport 4400 Release Notes for R4.0



38 Chapter 2 New Features and Software Enhancements
• TOS (Type of Service) to help ensure QOS, and 

• RTP (Real Time Protocol) provides end-to-end delivery services for IP 
packets with real-time requirements. 

• Voice over IP and Voice over Frame Relay operate simultaneously in the same 
unit.

• Available in all Passport 4400 voice modules and voice services.

Install Tool 4.0

• Now supports 4.0 features.

• Adds service-specific wizards.

• Increases the amount of information collected for the Passport 4400 regarding 
status and troubleshooting/diagnostic information.

Passport 4400 Configurator

The Passport 4400 Configurator is an embedded web server and HTML pages, 
which resides in the operating code of each Passport 4400 unit. Passport 4400 
Configurator performs complete Passport 4400 device configuration, monitoring 
and diagnostics using Netscape Communicator Release 4.5 (with Navigator 
browser 4.08) or later and Internet Explorer 4.01 SP2 or later. Passport 4400 
Configurator serves as an alternative to the Command Line Interface (CLI).

Note: VoIP is not supported over RFC 1490 PVCs.

Note: Passport 4400 Configurator is released at Version 4.0. Some 
references in the documentation may reference Version 1.0; this was a 
preliminary version number. Version 1.0 and 4.0 are essentially the same.
Part No. 800-1953-40, Rev. C



Chapter 2 New Features and Software Enhancements 39
Software Enhancements from the Previous Release

• Enhanced video support for CBR. You can now run video up to 512 Kb/s. 
Previously this was not supported.

• Increased RFC 1490 PVCs from one to twelve.

• CRC errors and CTS/RTS control signals now displayed via Command Line 
Interface.

• Backup Link Switchback timer is now configurable to 24 hours.

• Interdigit delay and Regeneration Delay Timers are now configurable from 
.1 sec (100ms).

• Management port parameters are now fixed at 8 data bits, 1 stop bit, no parity.
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Chapter 3
Operational Notes/ Known Issues

Resets

In resetting the unit, it is recommended that you use the reset system current 
option to reset all the devices within the unit (hardware reset). In many cases, 
selecting reset system cpu is not adequate, because only the cpu software will 
reset.

General Operational Notes

• Changing the IP address of the unit without changing the PC dial-in IP 
address for the PPP over management port functionality may prevent access 
of the Configurator or Install Tool.

• Idle Character: In Release 4.0, the idle character default is now 126 (7E); to 
get a mark fill (FF), set your idle character to 255.

To further ensure proper operation of the Passport 4400 4.0 software, 
please refer to the Passport 4400 Engineering Notes and Guidelines 
document, which can be found on the following Web site:

http://esweb2.us.nortel.com/imds?pg=/prod/                                                                                               
passport4000&view=TechnicalTools

This document provides guidelines to proper integration of the Passport 
4400 into your network, and offers suggested configuration settings 
based upon specified network scenarios.
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• When using the IP priority feature between the Passport 4400 and Passport 
6400, a problem has been seen where the priority of an outgoing FTP file 
transfer tagged as High is erroneously tagged as Low when forwarded from 
the Passport 6400. This problem has only been seen with FTP and not with 
other types of IP traffic. It is being researched if this is a product defect or 
configuration issue. Contact your Certified Distributor or Account Manager 
for additional information and updates.

• Before opening/starting your Passport 4400 Configurator, ensure that 
“cookies” is enabled in your web browser (refer to your browser 
documentation).

SNA Services

• 60316562

In certain network configurations the host may poll the controllers before the 
Passport 4400 unit establishes SNA communications. Some SDLC PUs may 
not become active immediately. The PUs may require a second poll from the 
host in order to become active after the Passport 4400 unit is restarted. 

One or more PUs may require an additional poll from the host before they will 
become active.

In order to reduce the amount of time the additional polls are sent from the 
host to the Passport 4400 unit, the poll timer can be set to a shorter interval. 
On the AS/400, within the controller description, the NDMPOLLTMR 
parameter can be set to a value of 1, which will cause the AS/400 poll the 
controller after 0.1 seconds, if there has been no response by the controller.

• 60322142

There is a known open issue with interworking to 3rd party FRADs and 
Routers, see page 50 (60322142):
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Voice Requirements

• Passport 4400 Network:

— You must set up the NAS/NAC services prior to establishing a call across 
the network.

• Note that when you set the fax rate (in voice profile) to 9600, voice calls will 
have 13,000 b/s reserved bandwidth. Because of this, the number of calls 
permitted across the WAN will be reduced. In Release 4.0 and later, there is 
feature that disables the bandwidth allocation. Information on this feature is 
documented in the Configuration and Operation online documentation. Be 
very careful with this parameter as it permits bandwidth overbooking which 
can result in voice degradation.

• RSI Server DNA: Do not add any RSI servers with a DNA that duplicates an 
existing RSI server’s DNA.

• Voice over IP (VoIP) is designed in this release for operation in only two 
ways:

— As a gateway behind a router.

— Connecting a frame relay and IP network together. (10309543)

• Passport 4400 Interworking with a Passport 6400:

— You must provision the VNCS RSA/RSI services prior to establishing a 
call across the network.

— Regardless of the configured fax rate, all calls from the Passport 6400 
MVPs will have 10,800 b/s reserved bandwidth for the voice session. 
(10309543)

• When you have voice or fax operating over the network and you perform a 
save function (from CLI, Passport 4400 Configurator, or Install Tool), there 
will be a momentary loss of voice or fax quality. Your fax call may drop. 
(60107780)

Note: Do not use VoIP over RFC 1490.
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Issues Resolved in Release 4.0

Install Tool

• Issue Resolved: The X.25 Annex G configuration and SNA RFC 1490 
configuration screens did not check if the DLCI was already in use on the 
selected port. This caused a failure when part of the configuration was not 
completed. This has been resolved. (60102950)

• Issue Resolved: The SNA local screen only displayed one Link Station 
Address, although you could add as many as desired. The problem has been 
corrected. (60102887)

• Issue Resolved: When configuring Transparent CCS, Install Tool assumed 
that for a dual port E1 card, the signaling data was on Time Slot 16 of the L1 
(Local) port. This has been resolved. (60104966)

System Software

• Issue Resolved: The trace log in the debug has been improved to capture and 
store information when a reset occurs. (10181419)

• Issue Resolved: The SNMP Agent did not generate a clear trap for traps 
cputilization or ramutilization. This no longer occurs. (10241428)

• Issue Resolved: Meridian 1, Release 24 did not work with Passport 4400 BRI 
voice applications. This is now fixed. (10284598)

• Issue Resolved: Unable to build trap rsiTrap. This is now resolved. 
(10304112)

• Issue Resolved: For every fax call made between Passport 6400 MVP and 
Passport 4400, the attribute frmLostInNetwork increases. This no longer 
occurs. (10307212)

• Issue Resolved: The Passport 4400 resetting from a HICOM PBX call no 
longer occurs. If a Call Setup Indication is received from the PBX as a BRI 
Interface Type in the Channel Identification IE, the call is rejected with Cause 
Code 66, Channel Type Not Implemented. (30131393)

• Issue Resolved: The parameter enums (for dcswitch) has been changed to 
disabled/enabled to be consistent with other objects in same table. (50134675)

• Issue Resolved: The parameter value for EgressString has been changed to 0 
to 36. (50318825)
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• Issue Resolved: The bandwidth utilization displayed for only one primary 
port when the show system statistics command was used. This is now 
corrected. (60082859)

• Issue Resolved: When the 56K CSU tx Out of Frame service was invoked 
and the PANL status displayed Down, the 56K link status displayed 
Operational instead of showing an alarm condition. This has been corrected. 
(60089712)

• Issue Resolved: IPX performance was degraded when the Passport 4400 unit 
was operating at 100% utilization. This has been corrected. Note: 
Please consult the Passport 4400 Engineering Guidelines document 
(URL: http://esweb2.us.nortel.com/imds?pg=/ prod 
passport4000&view=TechnicalTools) to make sure you have configured your 
Passport 4400 unit(s) to operate properly in your network. (60089850)

• Issue Resolved: E1 CSU set commands required the save configuration 
update and system reset commands before the parameter configuration 
took effect. This is now fixed. (60090108) 

• Issue Resolved: The CLI show presentations were not accurate when you 
requested a show command after provisioning more than the maxdlcsperline 
configuration allowed. This is now fixed. (60090355, 60090367)

• Issue Resolved: When provisioning an ISDN BRI WAN interface as a leased 
line backup from the Passport 4400 to the Passport 6400, the PANL protocol 
fails to establish a connection. This is fixed in Release 4.0. (60090368)

• Issue Resolved: The CLI command sh ipx rip cir t was always 0 for 
Tx Pkts for all ipx circuits. This has been resolved. (60090878)

• Issue Resolved: The loopback feature for troubleshooting the ISDN BRI U 
interface is now functional. (60091331)

• Issue Resolved: The Passport 4400 unit continually output the message reset 
dte 162 to the mb3XAP. This no longer occurs. (60096111)

• Issue Resolved: The voice channel status has been changed when the digital 
voice channel is not mapped to a T1/E1 timeslot. It was 
"pcmChannelNotInstalled" and now is "pcmChannelNotAssigned". 
(60096861)

• Issue Resolved: SDLC traffic: There was an extreme delay (300 sec.) before 
SDLC traffic began to pass through an RFC-1490 BAN network. The SDLC 
link now becomes active within one minute. (60099706)

• Issue Resolved: X.25 PVC stayed in 'out-of-order' state and required a reset. 
This no longer occurs. (60101926)
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• Issue Resolved: MIB object rxQueueSize in the WAN MIB has been 
removed. Is is no longer supported. (60103118, 60103119)

• Issue Resolved: A memory leak was found: Basically, all sh sna commands 
caused a memory leak. Install Tool sent sh sna commands to a Passport 4400 
unit continuously, and the operating system memory depleted very quickly. 
This no longer occurs. (60103672)

• Issue Resolved: Improvements have been made to show the correct remote 
voice channel status for Hoot N Holler applications. (60103821)

• Issue Resolved: LMI failed conformance test cases. This has been resolved 
and LMI now passes the conformance tests. (60104490, 60104492)

• Issue Resolved: The following CLI presentations have been corrected to 
show 1-36 as the range of options: (60314486)

— set voice egressTable manipulationString

— set voice egressTable phoneNumber

— set voice ingressTable ingressNumber

— set voice ingressTable ManipulationString

— set voice nac cache egressString

• Issue Resolved: Frame relay CLI displayed a wrong name for attribute 
"TxPriority." This is now fixed. (60109523)

• Issue Resolved: The ISDN hardware revision 8 “U” interface now passes 
diagnostic after code download during initialization. (60314787)

• Issue Resolved: At the Central site, when the ISDN cable was removed, 
frame relay remained up. This no longer occurs. (60314963)

• Issue Resolved: GCM MIB correction: it was missing enums for object 
mcmGcmHwStatusIndex. (60316984)

• Issue Resolved: When committing software after downloading new operating 
code, the Passport 4400 displayed BRI voice channel trap frame sync loss 
traps erroneously. This has been corrected. (60317396)

• Issue Resolved: A BRI voice trap now occurs if the BRI hardware is 
defective. (60317451)

• Issue Resolved: PANL link synchronization was intermittently lost and 
recovered only after a node reset. PANL recovery has been corrected. 
(60317464)

• Issue Resolved: Setting the SNA llc inact timer to 0 no longer causes a bus 
error. (60317816)
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• Issue Resolved: Voice parameters BckGrndNoiseLevel and 
SilenceHngOvrTime now migrate properly during an upgrade to a new 
software version of Passport 4400. (60317864)

• Issue Resolved: The BRI Voice Module statistics have two new statistic 
counters: Egrbufunderrun (egress overrun) and egrbufoverrun – (egress 
overrun). (60317918)

• Issue Resolved: Whenever the T1/E1 software residing on the module was 
different from the one in image bundle, a message prompted you to download 
the image software. This message sometimes did not show up and sometimes 
it was misleading. This is now corrected. (60318120)

• Issue Resolved: The BRI voice channel did not always complete a call 
successfully if the call was originated from an external ISDN network. This 
has been improved for calls from Passport 4400 to Passport 4400. A future 
upgrade to MVP is required for calls from a Passport 4400 to Passport 6400 to 
be successful (60318543)

• Issue Resolved: The ISDN backup port did not come up after being 
temporally set to down and up with CLI commands. This has been corrected. 
(60318790)

• Issue Resolved: After switching to an ISDN backup link and the primary link 
on port 2 went up and down, PANL connection sometimes did not recover 
until a node reset was invoked. This has been corrected. (60318813)

• Issue Resolved: With the BRI Voice Module in NT mode, during power up 
diagnostics for the Logical Interface Module (LIM) B, BVM/1 Failed. 
However, the hardware was operational. This has been corrected to reflect 
proper status of the diagnostics. (60318868)

• Issue Resolved: There is now a fix for the BRI Voice channel fax issue with 
Cannon model B100. (60319278)

• Issue Resolved: The ISDN backup intermittently failed to connect if physical 
cable was disconnected and connected. This has been resolved. (60319279)

• Issue Resolved: The branch node was configured with an SVC call where the 
DNA was set only to the DNA prefix of the remote side. After rebooting the 
branch side, the remote side reset after 10-20 minutes. The cause was the 
system ran out of stream buffers. This has been corrected. (60320321)

• Issue Resolved: The command sh sy card displayed an incorrect part 
number for the single port TVM. This has been corrected.
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Open Known Issues

Passport 4400 Configurator

• Note: Passport 4400 Configurator requires Netscape Communicator, 
Release 4.7 or later or Microsoft Internet Explorer, Release 4.01 SP2 or 
later. Note that it does not work with Netscape Navigator 4.0.8 (even though 
the browsers carry the same release number). (60101711)

You may experience problems if using Netscape Navigator and resizing the 
Navigator Tree windows. Microsoft Internet Explorer does not exhibit these 
problems. (60107223, 60107227, 60107233)

• Issue: When using Win 98, you may need to manually switch between the 
PPP Adapter and the Ethernet NIC in order to establish the connection. This 
can be done using the winipcfg utility. (60098956)

• Issue: When using, Internet Explorer, the system reset progress bar does not 
update properly after resetting the Passport 4400 unit from the System Reset 
page.

Resolution: Use Netscape Communicator. This will be fixed in a future 
release.

• Issue: Unable to add a static route. There is a problem with the validation 
functions.

Resolution: Use the CLI to add static routes. This will be fixed in a future 
release.

Install Tool

• Issue: When both Install Tool and Telnet are used on a 9600 baud PPP 
connection, Telnet response will be slow. (60105799)

Resolution: Increase the baud rate on the management port to a higher speed 
(such as 38400). If this doesn’t work for you, you can Telnet to the Passport 
4400 unit outside the Install Tool application.

• Issue: A problem sometimes occurs when a configuration panel and a test 
panel are opened simultaneously on the same port. The flashing appears to 
affect all the ports and the backpanel display by flickering each in turn. 
Closing either window turns off all the flashing. The problem will be 
corrected in a future release. (60103370)
Part No. 800-1953-40, Rev. C



Chapter 3 Operational Notes/ Known Issues 49
• Issue: Install Tool does not support the creation of virtual ports for “Basic” 
routing of IP on a Central or Regional site. It automatically turns on 
Easy-Routing on Interface 2 when the site is Regional or Central. (60104820)

• Issue: Install Tool chooses default priorities for the voice and data services it 
configures. It does not configure the IP Prioritization feature on a 
Passport 4400 unit. (60099843) 

Resolution: You can do the basic setup using Install Tool, then use the 
Passport 4400 Configurator or the CLI to customize the data flow by creating 
new virtual ports and SVCs for the data you want to have at a different 
priority. This feature will be included in a future release.

• Issue: Microsoft Windows icons sometimes display improperly. There are 
several instances documented in the MS Developers Documentation where 
icons are displayed improperly. This is due to a problem with the 
“ShellIconCache” file saved by Windows on shutdown and re-loaded on 
startup. If this file gets corrupted (and simply changing the contents of an Icon 
file without changing the name can do it), icon display problems can occur. 
(For further information see article Q133733 in the Microsoft Developers 
documentation on their web page.) (60102656)

Resolution: To resolve this issue, restart the computer in MS-DOS, delete the 
ShellIconCache from the Windows/Winnt directory and then start windows. 

• Issue: On Windows platforms with less than 128 MB of memory, and 
Windows managing virtual memory, you may need as much as 120 MB of 
disk space on the C: drive if your swap space, Windows directory, and Install 
Tool installation directory are all located on that drive. This memory is only 
used during installation; Install Tool uses only 20 MB or so after the 
installation finishes. Install the Install Tool on another drive, or free up 
enough room on the primary drive.

• Note: It is recommended that you delete ifIndex 147/149 if you are not using 
them. If they exist but are not used, Install Tool reports a yellow status for the 
port, indicating that one or more DLCIs are not functioning properly.
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System Software 

• Issue: Interworking problems with 3rd party FRADs and Routers. The Local 
Ring Number is currently set to null, which is an invalid entry. The SDLC 
service to 3rd party devices will not initialize. (60322142)

Resolution: This will be fixed in a special release. Contact your Certified 
Distributor or Account Manager for additional information.

• CBR and HTDS Sync Functions. The Passport 4455 running one or two 
8-channel High Speed Data Modules (HDM) experience some problems when 
running CBR and HTDS. The current resolution is to use the 4-channel HDM. 
(10311756, 60315773)

• For the HTDS, CBR, SNA, and X.25 protocols: When the idle character is set 
to 255 the port will use mark fill instead of flag fill while the line is idle.

— When using mark fill, RTS/CTS is raised when data is being sent, and 
lowered when there is no data to send. When using the NTAU18AA or 
NTAU19AA RS-232 cables, a modification of the DB-25 end of the cable 
may be needed if the attached device needs RTS/CTS high all the time.

— A new to-DTE cable, NT0263AA (shown on page 41) has been created 
that sets CTS high, regardless of the idle character setting. This can be 
used in place of the NTAU19AA.

— All other values for the idle character will use flag fill (hex 7E, decimal 
126). 

— When using flag fill, RTS/CTS is held high at all times.

Existing applications using these protocols may need to change the idle 
character from the default of 255 to 126 to keep the same flag fill 
functionality found in previous revisions.

• Issue: Ping timing out. (60102211)

Resolution: When performing a ping, consider the following:

• If packets are too large, packet time out could occur.

• A large number of hops increases the probability of packet time out.

• Bandwidth availability on the Passport 4400. (Insufficient bandwidth 
could also cause packet time out.)

Any one of these items or a combination of two or more could result in a ping 
timing out. 
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• Issue: Meridian Release 24 does not work with Passport 4400 BRI voice 
applications. Release 23 has been fully validated with Passport 4400 Release 
3.1 and 4.0. Testing in Simi Valley labs has determined that Meridian 
Releases 23 and 24 will not interwork together over the BRI using Qsig. 
(10284598)

• Issue: PVCs in the X.25 services might not recover properly when a reset is 
requested by the packet layer protocol or when a Reset command is issued 
from an X.25 terminal. The reset would normally occur after error conditions 
such as protocol violation, out of sequence errors, or network failure. 
(60101926, 6009611)

Resolution: If the PVCs do not recover, you can either issue a Restart 
command from an X.25 terminal, or you can reset the Passport 4400 unit. In 
either case, all calls are cleared.

• Issue: It is impossible to establish a call from a Passport 6400 to a Passport 
4400 after an unspecified period of time. (30318566)

• Issue: The ARP table on the Passport 6400 displayed only one entry which 
was the lowest TP SPVC coming from the Passport 4400. Even though there 
is only one entry shown, the other two SPVCs were passing traffic. After 
several locks and unlocks of the DLCIs all 3 ARP entries will display. After a 
reboot of the Passport 4400, the Passport 6400 will display only the lowest 
priority entry again. (60320016)

• Issue: When deleting RFC 1490 tunnels more than one time and rebooting, 
the configuration table becomes corrupted. Adding tunnels does not cause any 
problems. (60319490)

Resolution: To work around the issue, currently use the following procedure:

• Upload the original configuration via ftp to a pc/workstation.

• Remove and add tunnels, or to simply remove more than one tunnel, do 
the following:

— remove all undesired tunnels

— add all new tunnels

— save configuration update

— reset the unit

If, in the future, you need to delete another tunnel, repeat the procedure. 
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Online Documentation

• Issue: Default window size causes problems with the text. (60105290)

Resolution: Set your browser window to 800 by 600 pixels or greater. 
Nortel Networks recommends that you maximize the window for optimal 
viewing.
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Install Tool (800-1983-40)

Null Driver

• Locating the Null Driver: The Install Tool installation process copies the null 
modem driver to your Install Tool installation directory. (The name of the 
modem is PP4400Direct.) The file name is PassportNullModem.inf. 
(60109124)

• Null Modem Driver Troubleshooting Tip: When you install Install Tool for 
the first time on a Windows 95 or Windows 98 workstation, the installation 
process installs TCP/IP, Dial-Up Networking, and the Passport 4400 null 
modem driver for you.

The Problem

However, if you uninstall the null modem driver and then reinstall [Product 
Name (short)], the installation process does not automatically reinstall that 
driver. Consequently, you will be unable to configure a Dial-Up Networking 
connection between your workstation and the Passport 4400.

The Solution

To avoid this problem, perform the follow sequence of tasks before 
reinstalling Install Tool:

a Go to the Windows directory.

b Change the display attribute to show all files (including hidden files).

c Go to the Windows\inf directory (normally, this directory is hidden).

d Delete the Windows\inf\passport.inf file.

e Change the Windows directory display attribute back to its normal state.
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Once you remove the passport.inf file, the [Product Name (short)] installation 
process will automatically reinstall the null modem driver. (60109069)

Security Considerations

There are two security-related issues to consider when planning your 
Passport 4400 device management operations.

Community Strings

The Passport 4400 uses SNMP version 1 for all of its device management 
operations (configuring, monitoring, resetting, and so forth). SNMP version 1 
uses community strings to control access to devices in a network. Since these are 
cleartext strings, they are relatively insecure.

You can use the Passport 4400 Configurator or the Passport 4400 CLI to change 
your community strings. However, since [Product Name (short)] does not include 
a provision to specify a community string, you cannot use [Product Name (short)] 
to access a Passport 4400 node whose community string has been changed from 
the default value (private). In this case, you must use either the Passport 4400 
Configurator or the Passport 4400 CLI to access the unit. This will be corrected in 
a future release of Install Tool.

Dial-Up Connections

The Passport 4400 provides a PPP stack, thereby enabling access to Passport 4400 
nodes through dial-up connections. This PPP implementation does not provide 
authentication controls. Therefore, if you connect a modem to a Passport 4400 to 
support a dial-up connection, that node becomes accessible to any remote host 
that knows the phone number of the modem and the community string of that 
node. Furthermore, any host that successfully connects to a dial-up port can 
potentially gain access to all devices that are visible to the Passport 4400. 

It is recommended that you take appropriate measures to protect your network 
from unauthorized access. For example: 

• If you access a Passport 4400 through a dial-up connection, disconnect the 
modem from the Passport 4400 at the completion of your session.

• Consider using a dial-back modem rather than a dial-up modem. 
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• Treat your community strings as passwords and manage them as you would 
any other password system.

For more information about dial-up connections, refer to Using the Passport 4400 
Install Tool V4.0 (800-1983-40).

Hardware Installation

• The ISDN BRI Voice Module has been updated to the following:

The ISDN BRI Voice Module (IVM-BRI/ST/2 - NTAU76CA) provides the 
Passport 4400 unit with an ISDN interface for connection to an ISDN PBX, ISDN 
phone, or other ISDN protocol and provides external clocking capability.

The NTAU76C requires Ethernet Base Module NTAU01CA Rev. 05 or later.

Note: The NTAU76BA, the previous release of the module, did not 
provide the BRI clock sync module for external clocking.

Attention

The ISDN BRI Voice Module will not operate with the Passport 4455. It is used only with 
the Passport 4430 and Passport 4450.

Note: With a Passport 4450, if the ISDN BRI Voice Module is in the top 
slot, you must use Rev .03 or later.
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The BRI module connects to the trunk side of an ISDN PBX, serving as one half 
of an ISDN tie trunk that connects two ISDN PBXs.

Figure 1   ISDN BRI Voice Module (S/T) and Pin Assignments

Pin 1

RJ-45

RJ-45 Pin Assignments

1
2

4
5
6
7
8

3

Pins 1, 2, 7, 8 Not Connected

Transmit Data to Network
Receive Data from Network
Receive Data from Network
Transmit Data to Network

Network Terminator Mode

RJ-45 Pin Assignments

1
2

4
5
6
7
8

3

Pins 1, 2, 7, 8 Not Connected

Receive Data from Network
Transmit Data to Network
Transmit Data to Network
Receive Data from Network

Terminal Equipment Mode

Back Panel

BRI Clock Sync Module
Part No. 800-1953-40, Rev. C



Chapter 4 Corrections/Additions to the Documentation 57
To ensure that your unit is equipped with the External Synchronization 
feature, check the part number tag on the face plate of the Ethernet Base 
Module. All units shipped from the factory after January 2000 to non-North 
American locations will have this modification. The tag should read 
NTAU01CA Revision level 05 (or higher). If there is any doubt about the unit 
you have, contact Nortel Networks Customer Service and refer to ECO 
E400399. They will let you know if the revision level of your unit includes the 
necessary features.

• The following table replaces Table 10-1 on page 10-2 of the Hardware 
Manual and now includes the ISDN BRI Module (60106517):

Note: If this module is installed in a unit that does not have a wiring 
change, it will revert to its internal clock and otherwise perform all other 
functions.

Table 1   Module Stacking Order

Module
Maximum 
Number in 
Unit

LIM
(Logical 
Location)

Slot
(Physical 
Location)

Stacking Rules to 
Follow

Analog Voice Module (AVM) 4 B, C, D, E B, C, D, E Anywhere

Universal Analog Voice 
Module (UAVM)

4 B, C, D, E B, C, D, E Anywhere

Digital Voice Expansion 
Module (DVEM)

2 C, D, E C, D, E Directly above TVM/
EVM

T1 Voice Module or E1 Voice 
Module (TVM/EVM)

1 LIM B only B, C, D, E Anywhere

ISDN BRI Voice Module 
(IVM-BRI)

4 B, C, D, E B, C, D, E Must be directly above 
data modules, base 
module, or another 
ISDN BRI module

Legacy Data Expansion 
Module (LEM)

2 2, 3, 4 C, D, E Directly above LDM

Legacy Data Module (LDM) 1 1, 2, 3, 4 B, C, D, E Directly above EBM or 
HDM

High-Speed Data
Module (HDM)

2 1, 2 B, C Directly above EBM or 
other HDM

Ethernet Base Module (EBM) 1 N/A A Always at bottom
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• The following cable, NTO263AA, has been added. This cable sets the CTS 
high regardless of the idle character setting. This can be used in place of the 
NTAU19AA.
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Passport 4400 R4 Configuration and Operation 
Documentation (Online Documentation)

• When configuring FRDCE Service with frame relay SVC between a Passport 
4400 and the Passport 6400, the Passport 4400 must be set to Master, and the 
Passport 6400 to Slave. Traffic Management with rate enforcement allows for 
correct operation of the configured CIR bandwidth. (60107059)

• Pathway: Voice Service ➜  Switch Profiles ➜  CLI Procedure for Setting the 
Voice Switch Profile Commands ➜  (Main window) Auto Call Type ➜  Next. 
Above the H4 “Configuration - at the Master End” (ref 60102653)

• Pathway: VoIP ➜ Setting Up ➜ Initial VoIP Setup ➜ next ➜ next ➜ next ➜ 
next:

Select NAS as the Address Server in the Voice Switching 
Profile

From the Configurator:

Select Configure and Voice from the navigation menu:

Note: The following is an example of how to set up a single Hoot N 
Holler channel. To configure multiple Hoot N Holler channels, each 
channel must have a unique switching profile number, and each 
switching profile must have a VNCS or NAS pointer.
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Click on Channels. You will see the Voice Channels screen:

At Voice Switching Profiles, select the profile you intend to use for the VoIP 
channels and click on the Modify button. You will see the Voice Switching 
Profile screen. Change the Address Server to NAS and click on the Save 
button:

At this point, the VoIP configuration is complete. You must reset the Passport 
4400 unit to put the configuration into effect.

From the CLI:

Enter the following command:
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CLI> set voice switchingProfile addServerSelect

Example: set voice switchingProfile addServerSelect 1 nas

At this point, the VoIP configuration is complete. You must reset the Passport 
4400 unit to put the configuration into effect.

• Pathway: Voice Services ➜ T1/E1 ➜ Diagnostics. The following procedure 
replaces the existing procedures:

Configurator Procedure for Using the Test Commands

To execute the system action parameters for the T1/E1 module, follow the 
Configurator procedures below:

a Click on Configure, Voice.

Parameter Range of Values Required Action

<Profile> INTEGER (1..32) Enter the number of the switching profile to be 
used for VoIP channels.

<addServerSelect> nas | vncs Select nas for VoIP operation.
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b Click on System Action. The Voice System Action window opens:

c At the top of the window, click on T1E1 System Action. The T1E1 System 
Action window opens:

d Click on the desired setting from the dropdown menu and click on Save. 
A Command Successful message appears.

The following table describes the available options:

• Pathway: TOC or Contents (from Reference) ➜ Administrating the SNA 
Services ➜ Configurator Administration Functions ➜  Defining SNA 
Parameters ➜  Defining SDLC Link Station.

Parameter Description

Download Downloads T1/E1 Module software from the local image bundle.

LED Test Initiates a T1/E1 Module LED Test.

Stop LED Test> Terminates a T1/E1 Module LED Test.

Reset T1E1 Resets the T1/E1 Module.
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Revised Retry Sequence Function for Configurator

The retry sequence is set for the local SDLC link station. A retry sequence is a 
series of retransmitted frames, data, or control, for which no positive 
acknowledgement is received. The retry sequence starts with a series of slow 
polls, followed by an indefinite number of fast polls if no positive 
acknowledgement is received during the slow polls.

The retry sequence function is different from that described in the Configuring 
and Operating the Passport 4400 Software. Here is the correct description of the 
parameters affecting the retry sequence.

The retry sequence parameters are accessed from the Modify a SDLC Link 
Station screen:
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The parameters involved with the retry sequence are,

• Rxmits per Retry Sequence

• Retry Sequence Interval

• Retry Sequence Count

Parameter
Range of 
Values

Default 
Value

Required Action

Rxmits per Retry 
Sequence

0..128 15 Enter the number of retries in a retry 
sequence for the local SDLC link station.
Related parameters:
• Retry Sequence Interval

• Retry Sequence Count
A retry sequence is a series of 
retransmitted frames, data or control, for 
which no positive acknowledgement is 
received. The retry sequence starts with a 
series of slow polls, followed by an 
indefinite number of fast polls if no positive 
acknowledgement is received during the 
slow polls.

0 means no retries. If Rxmits per Retry 
Sequence is 0, then Retry Sequence 
Interval and Retry Sequence Count also 
must be 0.
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Retry Sequence 
Interval

0..255 50 Enter the length of time between retry 
sequences for the local SDLC link station. 
This parameter is effective only if Rxmits 
per Retry Sequence is greater than 1.

Related parameters: Rxmits per Retry 
Sequence
• Retry Sequence Count

For slow polls, the retry sequence interval is 
4 times the value specified for this 
parameter, in milliseconds (example: 50 * 4 
= 200 milliseconds).
For fast polls, the retry sequence interval is 
2 times the value specified for this 
parameter, in milliseconds (example: 50 * 2 
= 100 milliseconds).
Setting this parameter to a low value (less 
than 50) may impact overall CPU utilization 
of the Passport 4400 unit.

Retry Sequence 
Count

0..255 40 Enter the number of times a retry sequence 
is repeated for the local SDLC link station.
Related parameters:

• Rxmits per Retry Sequence
• Retry Sequence Interval

Parameter
Range of 
Values

Default 
Value

Required Action
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• Pathway: TOC or Contents (from Reference) ➜ Administrating the SNA 
Services ➜ CLI Administration Functions ➜  Defining SDLC Link Station.

Revised Retry Sequence Function for the CLI

The retry sequence is set for the local SDLC link station. A retry sequence is a 
series of retransmitted frames, data, or control, for which no positive 
acknowledgement is received. The retry sequence starts with a series of slow 
polls, followed by an indefinite number of fast polls if no positive 
acknowledgement is received during the slow polls.

The retry sequence function is different from that described in the 
Configuring and Operating the Passport 4400 Software. Here is the correct 
description of the parameters affecting the retry sequence.

The retry sequence parameters are accessed from the Modify a SDLC Link 
Station screen.

The parameters involved with the retry sequence are,

• define sna sdlc linkstation mRetries

• define sna sdlc linkstation nRetries

• define sna sdlc linkstation tRetries

CLI> define sna sdlc linkstation mRetries

Parameter Range of Values Required Action

<IfIndex> Integer (1..255) Enter the IfIndex of the link 
station.
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CLI> define sna sdlc linkstation nRetries

<Address> Integer (1..254) Enter the link station address 
(in decimal).

<MRetries> Integer (0..128) Enter the number of retries in a 
retry sequence for the local 
SDLC link station.
Related parameters:

• define sna sdlc linkstation 
tRetries

• define sna sdlc linkstation 
nRetries

A retry sequence is a series of 
retransmitted frames, data or 
control, for which no positive 
acknowledgement is received. 
The retry sequence starts with 
a series of slow polls, followed 
by an indefinite number of fast 
polls if no positive 
acknowledgement is received 
during the slow polls.
0 means no retries. If mRetries 
is 0, then tRetries and nRetries 
also must be 0.

The default value is 15.

Parameter Range of Values Required Action

<IfIndex> Integer (1..255) Enter the IfIndex of the link 
station.

<Address> Integer (1..254) Enter the link station 
address (in decimal).

<NRetries> Integer (0..255) Enter the number of times a 
retry sequence is repeated 
for the local SDLC link 
station.

Related parameters:
• define sna sdlc 

linkstation mRetries

• define sna sdlc 
linkstation tRetries

The default value is 40.

Parameter Range of Values Required Action
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CLI> define sna sdlc linkstation tRetries

Parameter Range of Values Required Action

<IfIndex> Integer (1..255) Enter the IfIndex of the link 
station.

<Address> Integer (1..254) Enter the link station 
address (in decimal).

<TRetries> Integer (0..255) Enter the length of time 
between retry sequences for 
the local SDLC link station.

Related parameters:
• define sna sdlc 

linkstation mRetries

• define sna sdlc 
linkstation nRetries

This parameter is effective 
only if mRetries is greater 
than 1.
For slow polls, the retry 
sequence interval is 4 times 
the value specified for this 
parameter, in milliseconds 
(example: 50 * 4 = 200 
milliseconds).

For fast polls, the retry 
sequence interval is 2 times 
the value specified for this 
parameter, in milliseconds 
(example: 50 * 2 = 100 
milliseconds).

Setting this parameter to a 
low value (less than 50) may 
impact overall CPU 
utilization of the Passport 
4400 unit.
The default value is 50.
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